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1.  About UDD 

Universal Dialogic Diagnostics (UDD) is a diagnostic utility used for testing the 
functionality of Dialogic SpringWare hardware. The utility relies on configuration 
data used to download firmware to a board. Any Dialogic SpringWare board 
configured to operate in a system and supported by the current version of UDD will 
appear on the UDD Main screen. 

UDD contains a list of tests that can be selected, deselected, and executed a 
specified number of times on each board. The tests available are specific to each 
type of board. For example, if you select the D/240SC-T1 board from the Main 
screen, only the tests specific to that board will appear on the Specify Tests screen. 

The UDD utility is documented in this User’s Guide, whether it is operating in a 
Windows or Linux environment. Information in this User’s Guide refers to all 
supported operating systems unless stated otherwise. Refer to the product Release 
Guide for operating system-specific information. 

NOTES: 1. For Windows: Online help is available whenever the F1 key is 
pressed. Pressing F1 once will retrieve specific help for the current 
screen choice. Pressing F1 again will retrieve more general help.

2. For Linux: Online help is available using the mouse.

1.1.  System Requirements 

UDD requires the base Dialogic System Release Software for your operating 
system. Refer to the product Release Guide for more information. 

For Linux only, the Sun Java 2 Runtime Environment, Standard Edition, version 
1.3 is required for operation of UDD. This can be obtained from the 
http://java.sun.com/j2se/ website.
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1.2.  Supported Boards 

Any Dialogic SpringWare board configured to operate in a system and supported by 
the current version of UDD will appear on the UDD Main screen. To be sure a 
board is supported in the current release, refer to the product Release Guide. 

1.3.  User Interface Considerations 

Selections are made using the mouse. In a Windows environment, shortcut keys can 
also be used by pressing the Alt key and the underlined letter of the screen 
selection. For example, “Run Tests” would be Alt-R. For more shortcut keys, refer 
to Table 2, “Main Screen Buttons”, on page 12 and Table 3, “Specify Tests 
Buttons”, on page 15. 

In Linux, the Alt key is not a function, but may be simulated by pressing the Esc 
key. For example, to simulate Alt-X, press the Esc key and then the X key. To exit, 
press the Esc key twice. 
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2.  Before You Begin 

This chapter provides information about preparing for, and starting the UDD utility. 
For information about UDD tests and their descriptions and parameters, proceed to 
Chapter 4, “UDD Test Descriptions”. 

2.1.  Installing UDD 

The way you install UDD depends on your operating system environment. Refer to 
the Software Installation Reference that accompanies the software for UDD utility 
installation instructions. 

2.2.  Verifying Board Configuration Data 

UDD relies on configuration data used to download firmware to a SpringWare 
board. Any Dialogic SpringWare board configured to operate in the system will 
appear on the initial UDD screen, providing it is supported by the UDD utility. 
Refer to the Release Guide for a list of supported boards.

NOTE: Update the SpringWare configuration files, if necessary, as described in 
the Dialogic Software Installation Reference before starting the UDD 
utility. 

The method used to record configuration data depends on your operating system 
and the base package installed on your system. Refer to the product Release Guide 
or the Software Installation Reference for more information about configuration 
data. 

2.3.  Preparing to Start UDD 

Before starting UDD, be sure that: 

1. The Dialogic System Release Software and SDK is properly installed. 

2. All active applications on any of the Dialogic boards in the system are stopped. 
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2.4.  Starting UDD 

The method used to start UDD depends on the operating system environment. Refer 
to the following guidelines: 

Refer to the product Release Guide for more information. 

2.4.1.  Startup Message 

When UDD starts, version information is displayed followed by the UDD 
initialization screen.

Any Dialogic SpringWare board configured to operate in the system and supported 
by the current version of UDD will appear on the initialization screen. Refer to the 
Release Guide for a list of supported boards.

2.4.2.  Error Messages 

An error message will appear if a problem prevents the UDD utility from starting. 
Possible error messages are listed in Table 1. 

NOTE: Unless indicated otherwise, UDD will exit immediately if one or more of 
the messages listed in Table 1 is returned. 

Operating System Method

Windows From the Dialogic System Software program folder, click 
Universal Dialogic Diagnostics Utility. 

Linux  From the command line, execute 
usr/dialogic/bin/udd. This command runs the UDD.
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Table 1. Error Messages 

Message Returned Possible Cause/Solution 

No supported or downloadable 
boards found in current 
configuration. 

No boards in the system. Configuration 
data exists, but was not found or failed to 
download. 

Cannot determine product for board 
pair: board ID = <number>, 
daughter ID = <number> 

The board product IDs read from the 
EEPROMs do not match a known or 
supported product. This may indicate a 
board failure. Contact the RMA 
Coordinator for further help (see 
Chapter 6, “The Return Material 
Authorization (RMA) Process”). If any 
board in the system does not have this 
problem, UDD will continue.

Cannot send command to <board 
name>.
Cannot read EEPROM for <board 
name>. 

Unable to communicate with the board. 
Check the hardware and software 
configuration. If any board in the system 
does not have this problem, UDD will 
continue.

Cannot find file: <filename>. A required file was not found. Verify that 
all required packages are installed. 

Environment variable <variable 
name> is not set. 

The environment variables DLCFGPATH 
and DLFWLPATH are used by UDD to 
locate files. These variables are often set 
in CONFIG.SYS when you install other 
required Dialogic software. To verify that 
they are currently set, type “set” to list 
variables and their values.

The messages shown in this table will appear on the screen, but will not be listed in the log 
file. 
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Cannot access board.
Skipping these boards.
Boards must be stopped before 
running this program.
Press Enter to continue. 

An application is running or the system 
cannot communicate with the board. Stop 
the boards before starting UDD. 

Cannot open: <configuration data> Incorrect DIALOGIC.CFG file or registry 
entry. Unable to open the configuration 
data. 

<configuration data>: invalid line: 
<line #>

Check the configuration data. 

Unknown board type specified for 
<board>

Unknown/unsupported board. If any 
board in the system does not have this 
problem, UDD will continue.

Table 1. Error Messages  (Continued)

Message Returned Possible Cause/Solution 

The messages shown in this table will appear on the screen, but will not be listed in the log 
file. 
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Download of system failed
followed by one of the following: 

Fatal error opening boot file.
Error reading boot file.
Unable to open GENBOOT.FWL.
Unable to open firmware file.
Old format or corrupted firmware 
file. 

GENBOOT.BIN is version 1.10 or 
earlier. 

GENBOOT not responding on 
board xx.
GENBOOT failed on board xx.
Failed to initiate GENBOOT 
download.
Failed to start firmware download 
of diagnostics firmware. 

Messages of this type indicate the 
following: 

A corrupt file or nonexistent file.

GENBOOT version is too old. 

No communication with product. 

No supported or downloadable 
boards found in current 
configuration data.
UDD Exiting. 

The system cannot find boards. Check 
configuration data. 

Table 1. Error Messages  (Continued)

Message Returned Possible Cause/Solution 

The messages shown in this table will appear on the screen, but will not be listed in the log 
file. 
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3.  Using the UDD Utility 

This chapter provides information about using the various features of the UDD 
utility. For information about UDD tests and their descriptions and parameters, 
proceed to Chapter 4, “UDD Test Descriptions”. 

3.1.  Using the UDD Utility

When you start UDD, a Start-up screen with the version and copyright information 
appears. For Windows, UDD will then display a warning that all Dialogic 
SpringWare boards will be stopped. For all operating systems, however, all the 
Dialogic SpringWare boards are stopped so that the UDD test firmware can be 
downloaded to the boards. For Windows, respond by pressing the Continue button 
on the Warning dialog to continue; otherwise, the UDD utility will exit.

An initialization screen appears next which displays information as the Dialogic 
SpringWare boards are found and the test firmware is downloaded. (This 
information actually comes from the UDD initialization log file, uddinit.log. This 
file is located in /usr/dialogic/dog for Linux systems; for Windows systems, use the 
Find Files utility to find the uddinit.log file.) You can scroll through this screen if 
needed. This screen will be covered by the UDD Main screen, but is available for 
viewing until you click OK to close it. 

The Main screen appears when the downloading is done. The Main screen appears 
similar to the one illustrated below.
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The Main screen displays all Dialogic boards currently configured in the system. 
Use the scroll bar, if necessary, to scroll through the complete list of boards. At the 
bottom of the screen are buttons for selecting screen options. Use the mouse or Tab 
key to select screen elements.

NOTE: Text that exceeds the field width will display “. . .” to indicate more text is 
available. Put the mouse cursor over the field to view the hidden text.

3.2.  Board Information

The Main screen displays the following information about each board: 

Product Dialogic product name. 
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3.3.  Menu Options 

The UDD Main screen contains the following menu selections:

3.4.  Button Options

The UDD Main screen consists of the buttons shown in Table 2. Use the mouse to 
navigate the Main screen.

Board Name The name given to the board in configuration data, ID=xx, 
where xx is the board number or address. Note that baseboard, 
daughterboard, dual board, and dual daughterboard have their 
own ID.

Serial No. Board serial number. 

Addr Base shared RAM address. 

Len Length of shared RAM. 

IRQ Valid hardware interrupt level. 

ID Board locator number. H represents hexadecimal 
(daughterboard id = baseboard id + 20Hex). For D/41D 
boards, the board ID is the base shared RAM address. 

Menu Item Action

File -> Exit Exit the UDD utility

Options -> Log Test Results Create a log file for test results

Help -> UDD Help Display online help for the Main screen

Help -> About Displays the UDD version and copyright 
information
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3.5.  Generating a Log File 

A log file, udd.log, can be used to store UDD test results. For Windows, the log file 
is not generated by default. To generate a log file of test results, use the mouse to 
select “Log Test Results” from the Options menu off the Main screen toolbar. For 
Linux, the log file is generated by default, but can be enabled or disabled in the 
Options menu. This log file is located in Program Files\Dialogic\Bin for Windows 
or /usr/dialogic/log for Linux.

3.6.  Selecting a Board 

To select a board, click the box next to the name of the board you wish to test.

Table 2. Main Screen Buttons

Button Action
Windows 
Shortcut Key

Select All Selects all boards listed on the Main screen. Alt-A 

Deselect All Deselects any boards currently selected. Alt-D 

Load Test Set Not supported. Alt-L 

Save Test Set Not supported. Alt-S 

Specify Tests Specifies which tests to run by displaying a 
Test Selection screen (one for each board 
selected). 

Alt-T 

View Log File Displays a log file of test results if logging 
was enabled. For more information, refer to 
Section 3.5, “Generating a Log File”, on 
page 12. 

Alt-V 

Run Tests Executes all selected tests. Alt-R 

Exit UDD Exits the UDD utility. Wait for UDD to 
terminate completely before proceeding with 
an application. 

Alt-X 
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When a board is selected, a check mark will appear in the box next to the board and 
the Specify Tests screen will appear. If you want to select more boards, bring the 
Main screen to the front. Select all of the products and boards you wish to test 
before you specify the tests to run on the boards.

You may select either a product name or individual board. If you select a product 
name, each board (daughterboard or dual board) that is part of the product will be 
selected automatically. If the board was not already selected, a check mark will 
appear to the left of the product name when you click that box. If the board was 
previously selected, clicking the box again will deselect it and the check mark will 
disappear.

3.7.   Specify Tests 

When you select “Specify Tests” from the Main screen, a Specify Test screen is 
displayed for each selected board. For a full description of UDD tests and 
applicable parameters, see Chapter 4, “UDD Test Descriptions”.
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The buttons available on the Specify Tests screen are listed in Table 3. 
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To specify which test(s) to run, click in the box next to a specific test or click 
“Select All Tests”. To deselect tests, click in the box next to a specific test or click 
“Deselect All Tests”. To set parameters (such as the number of iterations), click 
“Use Custom Parameters”. 

After tests are specified for all boards, you must select OK in order for UDD to 
return to the Main screen. 

3.8.  Run the UDD Tests 

As tests run, a Test Progress screen appears as shown below. It indicates the product 
being tested, the specific test name, and the status of the test. 

Table 3. Specify Tests Buttons 

Menu Option Action
Windows 
Shortcut Key

Select All Tests Selects all tests specific to a selected 
board. There is an option to set test 
parameters for each test. Test 
parameters are set by selecting either 
“Use Default Parameters” or “Use 
Custom Parameters” column from the 
Specify Tests screen. 

Alt-A 

Deselect All Tests Deselects any tests currently selected. 
This option does not reset any 
parameters.

Alt-D 

OK Returns to the Main screen after tests 
have been selected for a specific board. 

Alt-O 

Cancel Returns to the Main screen before all 
tests have been selected. 

Alt-C 

Help Activates context sensitive online help. Alt-H 
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In Windows, dots across the screen indicate continuing progress. Selecting all tests 
for multiple boards can take several minutes to run. When all tests are run:

• If successful, the Done button is enabled, the Abort buttons are disabled and 
the text “no errors found” appears. 

• If any failure occurs, a new screen appears displaying information about the 
failed board(s). Click the Details button on this screen to view the details about 
the failed board(s).

3.9.  Abort Tests 

You may choose to abort a test while a test run is in progress. To abort the current 
test, click “Abort Current Test” from the test progress screen. To abort all tests, 
click “Abort Entire Test”. An “Aborting test. Please wait...” message will appear on 
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the screen regardless of the abort option chosen. The final status of the test will be 
shown as “**ABORTED**”. 

3.10.  Monitoring Test Status 

A test will result in one of the following outcomes: 

• PASS indicates successful completion of all iterations. 

• FAIL indicates a failure when running a test. (The test ends when the first 
failure occurs.) 

• REJECTED indicates a failure during test initialization. 

• ABORTED indicates the user aborted a test. 

Upon completion of all tests, a test results screen indicates the product name, test 
type, and a test result message, for example, FAILED or REJECTED. To receive 
more information regarding failures, click “Details”. 

NOTE: No details are given for PASS or ABORTED results. 

3.11.  Ending a UDD Session

When you are done with the UDD session, click Exit UDD from the Main screen. 
You will have to run dlstart to download the Dialogic firmware to the boards and 
start the boards up.

The log file is written over upon restarting UDD. Therefore, if you want to save the 
results, rename the log file.
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4.  UDD Test Descriptions 

This chapter describes the tests that make up the UDD utility. Because UDD tests 
are specific to each board type, the tests listed in the Test Selection screen will vary 
with the type of board selected. 

Consult the product Release Guide to determine which boards are supported by this 
version of UDD. 

4.1.  Board Sanity Check 

The Board Sanity Check tests the basic functionality of the board. This test includes 
short versions of the Shared RAM, Local RAM, DSP, EEPROM, and Board Timer 
tests. 

Parameters 

4.2.  Shared RAM Test 

The Shared RAM Test verifies the available memory shared between the host and 
the board selected. 

Parameters 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767
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4.3.  Local RAM Test 

The Local RAM Test checks the local memory of the control processor on the 
selected board. 

Parameters 

4.4.  DSP Test 

The DSP Test verifies the board’s Digital Signal Processing (DSP) subsystem. This 
test checks DSP memory, interrupts between the DSP and the control processor, 
and the DSP’s crystal speed rate. 

Parameters 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767 

Starting Address Zero-based hexadecimal value of the address in Local 
RAM where the memory test will be started. 

Default: minimum offset allowed (0x10000 on 
D/xxxSC)
Valid Range: 0x10000 to 0xDFFFF 

Number of Bytes Hexadecimal number defining the number of 
consecutive bytes in tested memory, starting from 
Starting Address. 

Default: 0xD0000
Valid Range: 1 to 0xD0000 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767
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4.5.  Board Timer Test 

The Board Timer Test checks the functionality of the control processor’s Timer 2 
channel on the selected board. 

Parameters 

4.6.  Onboard Interrupt Test 

The Onboard Interrupt Test checks the functionality of the local interrupt system on 
the selected board. 

Parameters 

4.7.  SC2000 Test 

The SC2000 Test applies only to boards having SC2000 circuitry. SC2000 circuitry 
supports the SCbus, which is the hardware pathway used for communication among 
Dialogic boards. The SC2000 test verifies SC2000 circuitry by performing a data 
loopback test, where data is transmitted from a DSP, looped back through the 
SC2000, and validated by the DSP. 

Select DSP Check box to select DSP X and/or DSP Y. If the board 
has only one DSP, the DSP X box is checked and both 
DSPs are greyed out.

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767
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Parameters 

4.8.  EEPROM Test 

The EEPROM Test verifies the selected board’s ability to read the Electronically 
Erasable Programmable Read Only Memory (EEPROM). A board uses this 
memory to store configuration data. 

Parameters 

4.9.  PC Interrupt Test 

The PC Interrupt Test checks the board’s ability to generate interrupts to the PC. As 
the board generates interrupts, the host counts them and verifies that the correct 
amount has been generated. 

Parameters 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767 
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4.10.  T1 Loopback Test 

The T1 Loopback Test applies to boards having a T-1 front end. This test uses the 
front end set to local loopback on boards with a T-1 digital network interface to 
perform signaling and data loopback tests. It is a stand-alone test and does not 
require any other network interface boards or external loopback connector. 

Parameters 

4.11.  E1 Loopback Test 

The E1 Loopback Test applies to boards having an E-1 front end. This test uses the 
front end set to local loopback on boards with an E-1 digital network interface to 
perform signaling and data loopback tests. It is a stand-alone test and does not 
require any other network interface boards or external loopback connector. 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767 

Signaling Test The DSP generates signaling information and verifies 
that it receives the same signaling information. The 
signaling test is run four times, alternating the possible 
patterns for the A and B signaling bits (for example, AB 
= 00, 01, 10, 11). 

Default: run test on all time slots
Valid Range: 1 to 24 

Data Test Generates a data pattern in the DSP and then verifies 
that the DSP received the correct data. 

Default: run test on all time slots
Valid Range: 1 to 24 
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Parameters 

4.12.  LS Frontend Test 

The LS Frontend Test applies to boards having a loop start front end. The LS 
Frontend default parameters test Dual Subscriber Line Audio-processing Circuits 
(DSLAC) by programming each DSLAC channel and verifying that the correct 
information was written. Tones are also played and verified on each DSP channel. 
This is a stand-alone test and does not require other network interface boards or an 
external loopback connector. 

Parameters 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767

Signaling Test The DSP generates signaling information and verifies 
that it receives the same signaling information. The 
signaling test is run twice. 

Default: run test on all time slots
Valid Range: 1 to 32 

Data Test Generates a data pattern in the DSP and then verifies 
that DSP received the correct data. 

Default: run test on all time slots
Valid Range: 1 to 32 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767

Analog Test Tests the DSLACs in analog loopback mode. 

Default: run the test on all channels
Valid Range: 1 to 16 
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4.13.  NS Hardware Test 

The NS Hardware Test applies to boards having 8031/80188 interrupts and an 
XILINX chip. The NS Hardware test verifies the Northern Telecom interface on the 
NS daughterboard of the D/42-NS board. It first tests the 8031/80188 mailbox and 
shared RAM, and then tests the C-84 chip set, which interfaces the NS 
daughterboard to the PBX. 

Parameters 

Digital Test Tests the DSLACs in time slot assigned loopback mode.

Default: run the test on all channels
Valid Range: 1 to 16 

Number of Iterations Decimal number indicating the number of times the test 
will be executed. 

Default: 1
Valid Range: 1 to 32767
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5.  Troubleshooting 

This chapter provides troubleshooting information.

5.1.  Troubleshooting Checklist 

An installation oversight often creates a problem in an assembled system or testing 
setup. When isolating a problem, check the physical equipment first. If problems 
continue, confirm that: 

• All boards are firmly seated and secured in their PC expansion slots. 

• Daughterboard modules are firmly seated on the baseboard. 

• For Linux, confirm that the Sun Java 2 Runtime Environment, Standard 
Edition, version 1.3 is installed.

• The IRQ setting of the board you suspect has a problem does not conflict with 
other expansion boards in your system. 

• Each ISA/BLT or hardware configurable board has a unique board locator 
number or shared RAM address. 

• The configuration data is correct. 

• The Dialogic System Release Software and SDK is properly installed. 

• The UDD software is properly installed. 

A known good board can be used to verify that the UDD software has been installed 
properly.
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6.  The Return Material Authorization 
(RMA) Process 

If there is a problem with your board after running UDD, you can return the board 
to Dialogic for service. The following sections outline the procedures that make up 
the Return Material Authorization (RMA) Process. 

6.1.  Before You Call 

Before calling Dialogic to return a board, check to see if the problem is due to a 
mistake or oversight in the installation process. (For more details, refer to the 
troubleshooting checklist in Chapter 5, “Troubleshooting”.) 

Please be sure to have the log file of UDD test results and the board serial number 
handy when you call. This serial number is an alphanumeric code (for example, 
CZ001000) located on a label attached to the board. 

6.2.  Contacting Dialogic 

Contact the Dialogic RMA Coordinator by calling (973) 993-3000 x6374. 
Telephone lines are open from 9 a.m. to 5.30 p.m. EST. 

The RMA Coordinator will ask you for the board serial number and a brief 
description of the problem. After gathering this information, the RMA Coordinator 
will process your return request, provide you with an RMA number, and tell you if 
the board is still under warranty. Boards under warranty are repaired free of charge 
(you must pay for shipping). For boards not under warranty, you will be charged a 
flat repair fee. 

6.3.  Returning the Board and Test Results 

Repack the board, observing correct static-handling procedures. (Refer to the 
appropriate Quick Install card for static-handling procedures.) Place the board in an 
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anti-static package and then put it in a shipping carton using appropriate packing 
material. Use the original shipping materials if possible. 

If you are shipping the board to Dialogic, you agree to insure the board or assume 
the risk of loss or damage in transit. The address of our office is: 

Dialogic, an Intel company 
1515 Route 10 
Parsippany, New Jersey 07054 

We recommend shipping the board by a service such as Federal Express or UPS 
Second Day Air Service. These services generally handle packages more carefully. 
Not only is there less danger of in-transit damage, but delivery is faster as well. 

Be sure to write the RMA number on the outside of the box you are shipping (for 
example, RMA #2201) and send the package to the attention of the RMA number 
assigned. 
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